’) HP ALM 11.00 Patch 16
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HP ALM 11.00 Patch 16 is a cumulative patch and includes the enhancements and fixed defects of patches 1
through 15.

Important: Install the patch only if you use the English-language edition of ALM.
This document provides the following information about HP ALM 11.00 Patch 16:

Known Limitations

Certified Environments

Fixed Defects
System Requirements

Installation Instructions

HP Software Support
Legal Notices

See also:
Issues Addressed by Previous Patches
OTA API Actions Appendix




Known Limitations
Lab schema verification throws an error. Repair does not fix the issue, the schema becomes corrupted.

Known workaround:
Go the the file db_xmImap.xml in the repository:

C:\ProgramData\HP\ALM\repository\sa\DomsInfo\MaintenanceData\SchemaXMLs\extensions\PCLAB_1.0\db_xml

map.xmi
original code: <i name="Runs_IX1" unique="false">

change to : <i name="RUNS_IX1" unique="false">

Then run verify/repair and it will pass.

HP-UX installation is not available for ALM 11 Patch 16.

Certified Environments

ALM 11.0 patch 16 is certified with PC 11.0 patch 07.

For an overall description of certified environments see the System Requirements section below.

Fixed Defects

General

QCCR1J62654 On some client machines, a “Class not Registered” error occured when attempting to run a test
set.

QCCR1J63865 When using Oracle DB, Project Names could not be retrieved using REST API when the logged-
in username contained uppercase letters.

QCCR1J62509 An error "Failed to create non-unique index 'CALCULATION_TASKS_IX2' on table
'CALCULATION_TASKS_CURRENT' database 'gcsiteadmin_db" was logged when configuring HP ALM. A
duplicate index issue was resolved.

QCCR1J62772 Repair button was missing in Add/Remove Programs when ALM Explorer was installed.

QCCR1J62177 User name was expected in QC Sense Server Configuration screen, even though the Windows
authentication was set.

QCCR1J63202 REST API “force-delete-children=y” did not work with Test folders or Test Set folders.

Customization

QCCR1J17196 Users from a custom group (created out of the “Viewer” group) were not allowed to delete
attachments, even if Update Attachment permission was selected.

QCCR1J61647 The option of setting the order of Visible Columns in Customization/Data-hiding was removed as
there is no meaning for the order of the columns in this context.
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QCCR1J63659 Customization template project migrated from Quality Center 10 to Application Lifecycle
Management 11 did not verify linked projects, although no errors were displayed.

QCCR1J63054 Adding a duplicate Test Set to the same Test Lab folder using REST caused the Test Set to be
added to the unattached folder.

Defect Module
QCCR1J63226 Defect ID field was hidden under a long label of the Defect ID field set by customization.

Requirements Module
QCCR1J62998 Updates to the rich text field were not visible to other users attempting to update the rich text field.

QCCR1J31669 Changes in Risk-Based Quality Management customizations were visible only to the user who
made those changes, and not to other users.

QCCR1J63530 In the Requirements module, when generating the traceability matrix, the "Source Requirements"
sheet in the Excel document was not created as expected.

Tests Module

QCCR1J63820 When reporting a defect from a test execution, the Detected in Cycle field was not automatically
filled in.

QCCR1J62709 After session timeout, Manual runner displayed an incorrect message and ceased responding.

QCCR1J63669 In the Test Lab module, Find and Replace functionality did not work as expected on the Planned
Host field.

QCCR1J63506 Attachments of test cases were not visible when adding the test cases to Test Lab.

QCCR1J64012 When a QuickTest Professional test run contained Run Iteration Parameter Values, loading the
Run took longer than expected.

QCCR1J64011 The Client module unexpectedly issued a getStepValues request when the Last Run Report view
was collapsed.

QCCR1J62149 Bulk update of test instances took longer than expected.
QCCR1J63330 Bulk update of a large number (>2000) of test instances took longer than expected.

QCCR1J62232 In Test Plan/Test Lab, when highlighting a field and selecting View > Replace, the selected "Find
in field" and "Value to find" fields were not taken from the selection but from another column in the grid.

QCCR1J62074 In Test Plan, the parameter values were lost when copying a test case and called template
together to a new directory.

QCCR1J62458 Although learning flows using Unified Functional Testing is not supported, the Learn Flow
operation was visible in the user interface when Unified Functional testing was installed.

Business Process Testing

QCCR1J28676 Providing multi-line values for Business Component parameters was not possible.



QCCR1J61903 When creating Business Component Requests from the Business Process Test script, the details
template text did not appear in the Detalils field.

QCCR1J63567 Filtering Business Components in the Component Request folder was not working as expected.

QCCR1J31912 Cutting and pasting Business Components in the Component Requests folder was not possible.

QCCR1J62583 The query included in the Get Simple Key Entities Procedure took longer than expected on a
large amount of data.

QCCR1J62895 When exporting iterations from a Business Process test to a .csv file and later importing them
back, the functionality of the the test broke, and it was not possible to access the first iteration data from the
iteration link.

Analysis
QCCR1J63074 In the Coverage Analysis dialog box of the Requirements module, the Copy to Clipboard option
did not copy the chart as expected.

QCCR1J63042 When exporting a dashboard page, 2-byte Column names did not appear in the pdf file.

QCCR1J28508 The error “Could not find ID field for entity Dashboard Page” wan encountered when a shared
dashboard URL was opened in a browser.

QCCR1J61743 In Project Report configuration, there was no Attachment sub-section for Test Instances.

Site Admin

QCCR1J63429 Favorite views of the Test Lab module were not available after upgrade from Quality Center 9.2.

QCCR1J62189 During an upgrade from Quality Center 10.0 to Application Lifecycle Management 11.0, the
following error occurred: "Exception occurred. ALM-E10011: Actual upgrade failed
com.mercury.td.saserver.maintenance.upgrade.ListsUpgrader"

System Requirements

This section includes recommended and supported environments for HP ALM 11.00 and HP Quality Center
11.00. It also describes system configurations for installing for HP ALM Starter Edition.

Important: The supported environment information is accurate for the HP ALM 11 release and for HP Quality
Center 11 release, but there may be updates for HP ALM 11 patches and HP Quality Center 11 patches.

For the most up-to-date system requirements and supported environments information, see
http://support.openview.hp.com/sc/support_matrices.jsp.This site requires HP Passport sign-in credentials. To
register for an HP Passport user ID, go to: http://h20229.www2.hp.com/passport-registration.html

Server-Side System Requirements

Following are the server system configurations for installing HP ALM 11.00 and HP Quality Center 11.00 on
Windows, Linux, and Solaris.
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Note that these requirements do not apply if you are utilizing Managed Software Solutions for Quality Center. In
that case, the Managed Software Solutions team provides a hosted version of HP Quality Center, so the only
requirements are the Client-Side System Requirements listed below.

All database servers, unless otherwise stated, have been validated on 64 bit configurations.

Windows: Quad Core AMD64 processor
CPU
Linux: Quad Core AMDG64 processor or equivalent x86-compatible processor
Memory (RAM) 4 GB minimum
Free disk space 8 GB minimum
ESX 4.1 certified in ALM Patch 06.
Virtualization
ESXi 5.0 certified in ALM Patch 09.
Operating Application Server Database Servers Web Servers HP ALM 11.00
System Patch Level
Windows Server JBoss 5.1 Oracle 10.2.0.4 JBoss 5.1 GA
2003 SP2 (32 bit) | \yep| ogic 10.3 SQL 2005 SP3 Apache 2.2
Windows Server ;
2003 SP2 (64 bit WebSphere 7.0.0.9 | Oracle 11.2.0.1 WebLogic 10.3
Windows Server SQL 2008 SP1 IHS Server
2008 SP2 (64 bit) 11S6
Sun Solaris 10 64 ns7
bit
Linux Red Hat 5.4
64 bit
HPUX 11.31v3
(64 bit Itanium)
Linux Suse 10 (64
bit)
Windows 2008 R2 Patch02
Windows 2003 R2 SP2
SP2
Microsoft MS SQL Patch 06
2008 SP2
Oracle 11.2.0.2* Patch 06
RHEL 5.6 Patch 06
Windows 2008 R2 Patch 06
SP1*




Operating Application Server | Database Servers Web Servers HP ALM 11.00
System Patch Level
[1S7.5 Patch 06

MS SQL 2008 R2 SP2
SP1

SUSE 10 SP4 x64 Patch 09
MS SQL 2005 SP4 Patch 09
Oracle 11.2.0.3* Patch 10
MS SQL 2008 SP3* Patch 10

Red Hat 5.7 Patch 10

Red Hat 5.8 Patch 10
MS SQL 2008 R2 Patch 13
Sp2*

Red Hat 5.9 Oracle 10.2.0.5 Patch 14

Note: For large production deployments it is recommended that HP ALM be deployed on 64-bit systems.

For environments marked with *, see the notes and limitations in the corresponding patch’s section.

Recommended Environments

The following table includes recommended configurations for each operating system.

Operating System Application Server Database Server Web Server
Win2008 SP2 64bit JBOSS 5.1 SQL 2008 SP1 JBOSS 5.1
Sun Solaris 10 64bit Weblogic 10.3 Oracle 10.2.0.4 Apache 2.2
Linux Red Hat 5.4 64bit | Weblogic 10.3 Oracle 10.2.0.4 Apache 2.2
HP-UX 11.31 v3 64bit JBOSS 5.1 Oracle 10.2.0.4 JBOSS 5.1
(Itanium)




Server System Configurations for Starter Edition

This section describes the server system configurations for installing a Starter Edition server.

Operating System

Database Server Application and Web Server
. Microsoft SQL Server 2005 SP2 JBoss
Windows XP (SP3) Express edition installed during the
Windows Server 2008 SP2 32 bit | installation process Note: Installed during the

installation process.
Note: Installed during the
installation process. If SQL Server
2005 or 2008 is already installed on
the server machine, you can instruct
Quality Center to use it, by
providing the administrator name
and password.

Client-Side System Requirements

This section describes the client system configurations for installing an ALM client.

CPU Core duo 1.6 Ghz (or higher) or equivalent compatible
processor
Memory (RAM) 2 GB minimum

Free disk space

2 GB minimum

Prerequisites

e Visual C++ 2005 SP1 ATL Security Update
Redistributable

e Microsoft .NET Framework 3.5 (SP1)
e Microsoft Office 2007 (SP2)

Screen Resolution

Minimum: 1024 x 768

Text Size (DPI)

100% (96 dpi)

Virtualization

Citrix 6.0 certified in ALM 11.00 p1.

Operating System Browser gztﬁkhfe{/tﬁo
e Windows XP SP3 32 bit e Microsoft Internet Explorer 7.0 GA
(Recommended) e Microsoft Internet Explorer 8.0
e Window Vista (SP1) 32 bit e Microsoft Internet Explorer 9.0
e Windows 2000 32 bit e ALM Explorer
e Windows 7 64 bit * patch 2*
e Microsoft Internet Explorer 9.0 Sp2




Operating System Browser Pach Level
e Microsoft Windows 7.0 SP1 64 bit Patch 06
e Microsoft Windows Vista SP2 32 bit* Patch 06
e Windows Server 2008 SP2 32 hit SpP2
e Windows Server 2008 R2 SP1* Patch 09
e Windows 7 SP1 32 bit* Patch 10
* Windows 7SP1 32 bit Microsoft Internet Explorer 10.0** Patch 14

Note: For environment marked with * see the notes and limitations in the corresponding patch ReadMe section.
Note: For environment marked with ** PC site should be added to IE 10 Compatibility view sites.

Note: ALM 11.00 client is certified on Windows 7 64-bit. However, the Quality Center client is still a 32-bit
application that is based on ActiveX 32-bit and runs under WOWG64 (the Windows 32-bit On Windows 64-bit
emulator).

To enable the Quality Center or ALM client on Windows 7 64-bit, use a 32-bit instance of Internet Explorer. By
default, 32-bit Internet Explorer is located in "C:\Program Files (x86)\Internet Explorer".

To verify that the client process is running in the emulation mode — open the Windows Task Manager Processes
tab. All 32-bit processes should be marked with*32.

For more details regarding this limitation, see:
http://support.microsoft.com/kb/282423

For more details regarding WOW®64, see:
http://msdn.microsoft.com/en-us/library/aa384249(v=VS.85).aspx

Since Quality Center Client runs as 32 bit process - 32Bit versions of Visual C++ 2005 SP1 ATL Security Update
Redistributable and Microsoft Office should be used.

HP Quality Center 11.00 and HP ALM 11.00 have been tested against FDCC regulations.

Installation Instructions

This patch is intended to be installed over HP ALM 11.00 only and any previous patches.

To check the version you are using, log in to ALM, and select: Help > About HP Application Lifecycle
Management Software > Additional Information. Another way to check the version is on the ALM Platform
machine: Control panel > Add or Remove Programs > HP Application Lifecycle Management > Support
Information.

Notes:

e In this section, “ALM Platform machine” refers to the server machine on which ALM Platform is installed.
All operations detailed below should be performed on the ALM Platform machine.
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o |IMPORTANT: To prevent loss of files that were added or changed in the gcbin application folder or the
site administration repository, before you install the patch, you must make sure they are saved in the

correct paths.

Integrations

Name Version Patch ALM Certified Comment /
Instructions
Performance Center 11.0 Patch 1
Patch 03 Patch 03
Patch 04v2 Patch 07
Patch 05 Service Pack 3
Patch 06 Service Pack 3
Patch 07 Patch 12
Sprinter 11.0 Patch 04 Service Pack 2 See Customizing
ALM > Customizing
the SA Repository
and Application.
QuickTest 10.0
11.0
11.0
Enterprise 2.60
Integration

To enable opening and running tests from with HP ALM 11.00 Service Pack 2, HP Sprinter 11.00 Patch 4 must be

installed. To install this patch, see the Sprinter Add-in page, Help > Add-ins > HP Sprinter.

Installing the Patch

This section describes how to install the patch on the ALM Platform machine.

Notes:

o Before installing the patch, make sure that all users are logged out of ALM. You can check active
connections from Site Administration, in the Site Connections tab.

o If ALM Platform is deployed over a cluster, you must install the patch on each of the cluster nodes.

e After the patch is installed, the next time users log in to ALM, new files are downloaded and installed on the
client machines. If file downloads are prohibited through your browser, you can install these files through the
HP ALM Client MSI Generator Add-in on the HP ALM Add-ins page, or contact
HP Customer Support (http://support.openview.hp.com/) for assistance.
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To install the patch:

1 Onyour ALM Platform machine, run the appropriate patch installation file for your server’s operating system,
and follow the installation and deployment instructions.

Platform To install:

Windows Run the latest patch executable (MSP - Patch-00x.msp or EXE - Patch-
00x.exe ) file

Solaris To install on a Solaris platform, in the command prompt, type:

Jpatch_installer.sh

Linux To install on a Linux platform, in the command prompt, type: ./
patch_installer.sh

HPUX To install on an HPUX platform, in the command prompt, type: ./
patch_installer.sh

2. After installing the patch, deploy the gqcbin.war file on the ALM Platform machine.

e If you use a JBoss application server, the war file is automatically deployed during the installation and
deployment process. The war file is named 20qcbin.war, and located in the following path:
<ALM_Platform_Deployment_Path>\jboss\server\default\deploy\

o If you use a WebLogic or WebSphere application server, proceed with the instructions for manually
deploying the gchin application.

Windows 2003 Installation notes: HP ALM patch installation might fail on windows 2003 with one of next errors:

¢ Failed to resolve source: The installation source for this product is not available. Verify that the source
exists and that you can access it. or “File was rejected by digital signature policy”

e The problem: the environment issue - memory allocation problem for large Windows Installer package or
a large Windows Installer patch package in Windows Server 2003.

e The fix: The detail explanation of the issue and hotfix provided by Microsoft
http://support.microsoft.com/kb/925336

Manually Deploying the Application

To apply the patch changes on WebLogic or WebSphere, you must manually redeploy the qcbin.war file after
installing the patch.

To manually deploy the application:
1. Stop the HP Application Lifecycle Management service.

e Stop the service using the WebLogic or WebSphere Management Console.
2. Undeploy the gcbin application from the application server.

a. Undeploy the gchin application using the WebLogic or WebSphere Management Console.
b. To enable you to redeploy the current war file in case you need to uninstall the patch and roll back to the
previous patch level, copy the gcbin.war file to another directory,
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3. Deploy the gchin.war file on the application server. The file is located in the following path:
<ALM Platform Deployment Path>/deployment/

o For details, refer to the HP Application Lifecycle Management Installation Guide: Deploying ALM
Platform on WebLogic or Deploying ALM Platform on WebSphere.

4. Start the HP Application Lifecycle Management service.

Uninstalling the Patch

This section describes how to uninstall the patch from your ALM Platform machine.

Notes:

e Before uninstalling the patch, make sure that all users log out of ALM. You can check active connections
from Site Administration, in the Site Connections tab.

¢ If ALM Platform is deployed over a cluster, make sure you stop all nodes of the cluster before uninstalling
the patch, and that you uninstall the patch from each of the cluster nodes.

¢ IMPORTANT: On Windows machine, to uninstall a patch you should have the ALM 11 installation source
files for your environment available, either on the installation DVD, or on the server machine.

¢ IMPORTANT: On UNIX systems, you must first remove higher patch levels. For example, it is required to
remove Patch02 before removing PatchO1.

If you use a WebLogic or WebSphere application server, undeploy qcbin.war before uninstalling the patch.
To uninstall the patch:
Windows systems: Uninstall the patch from Control Panel. In order to display the installed patches:

¢ Windows Server 2003: Select the Show updates checkbox.

o Windows Server 2008: Select the View Installed Updates checkbox.

Unix systems: Run patch_uninstall.sh located in
var/opt/HP/iIHP/HP_ALM_Platform/11.00.000/patches/ALM11PATCH_<xxxxx> (‘xxxxx’ represents the patch level)

If you use a WebLogic or WebSphere application server, deploy the backed up qcbin.war file manually. For more
details, see Manually Deploying the Application.

ALM UNIX Non-root Installation
Defect ID: 97163 [internal]

By default, the ALM installer for UNIX/Linux platforms (Solaris, HP-UX and Linux) mandates that the current user
be the root user. This is because the ALM installer is based on OS native packages (.Ipp, .sparc, .depot, .rpm),
which all require root users.

There are cases in which the ALM Admin user installing ALM is not granted root privileges.
Note:

When installing ALM 11 RTM on HPUX, the file “HPUX_lib.sh” that is located at <ALM11 installation>\
HPUX\sequencer\foundation\OS _ specific\ should be replaced with the attached “HPUX lib.sh”.
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Instructions:
e Add “ALM admin user” R/W permissions to the /var/opt/HP folder.

e The root user (i.e., administrator/owner) of the target machine uses his/her root privileges to create an
<ALM _install_directory> to which the root user alone has write access.

e The root user edits the sudoers file (see below) and allows the ALM Admin user to run any file under the
<ALM _install_directory> with root privileges
For example, if the root user decides that the <ALM_install_directory> is /opt/HP_install/, the following
line should be added to the sudoers file:
gcadmin ALL=NOPASSWD:/opt/HP_install/

e For every new ALM installation or patch, the ALM Admin user asks the root user to copy the installation
files into the <ALM_install_directory>. The root user has a chance at this point to install the package on a
test machine to verify that the package does not contain any security issues.

e The ALM Admin user runs the installer.sh script file with the “sudo” prefix (e.g., sudo ./installer.sh). The
installer runs under root credentials and the installation runs successfully.

e Cancel the configuration wizard (still as the sudo root user).
¢ Run configuration from the installation folder - run_after_install.sh (as the ALM Admin user).
e Start JBoss (as the ALM Admin user).

If a mistake was made and the configuration wizard was executed as root (as sudo), the user must request that the root
admin change ownership of the files to ALM Admin user under the following locations:

o /var/opt/HP/ALM
e $TEMP (only the files related to Quality Center: QCServer.log*, QcSpring.log*)
o {JBoss deployment path}
¢ {Repository path}
This document assumes that the target machine has sudo installed on it.

The Sudo package is included by default on some systems. If it is not included by default, it can be downloaded
from the Web and installed.

Using Role-Based Access Control (RBAC) can also solve the problem in an equivalent way to Sudo. More
information regarding RBAC can be found at http://fengnet.com/book/Solaris_admin/ch1llevlisec4.html

The following matrix lists the appropriate Sudo and RBAC versions for each platform:

Platform | Sudo RBAC

Linux Available by default N/A

Solaris Can be downloaded Available by default (version 8,9 and 10)
http://www.gratisoft.us/sudo/download.html http://www.softpanorama.org/Solaris/Security/

solaris_rbac.shtml

HP-UX Can be downloaded Can be downloaded

http://www.gratisoft.us/sudo/download.html https://h20392.www2.hp.com/portal/swdepot/
displayProductinfo.do?productNumber=AccessControl
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HP Software Support

You can visit the HP Software Support Web site at: www.hp.com/managementsoftware/services

HP Software online support provides an efficient way to access interactive technical support tools. As a valued
support customer, you can benefit by using the support site to:

Search for knowledge documents of interest

Submit and track support cases and enhancement requests
Download software patches

Manage support contracts

Look up HP support contacts

Review information about available services

Enter into discussions with other software customers
Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also require a
support contract. To find more information about access levels, go to:
www.hp.com/managementsoftware/access level

To register for an HP Passport ID, go to: www.managementsoftware.hp.com/passport-registration.html|

Legal Notices

© Copyright 1992 - 2013 Hewlett-Packard Development Company, L.P.

For information about third-party and/or open source license agreements, see the Licenses directory on the
product installation media.

Confidential computer software. Valid license from HP required for possession, use or copying. Consistent with
FAR 12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and Technical
Data for Commercial Items are licensed to the U.S. Government under vendor's standard commercial license.

The only warranties for HP products and services are set forth in the express warranty statements accompanying

such products and services. Nothing herein should be construed as constituting an additional warranty. HP shall
not be liable for technical or editorial errors or omissions contained herein.

The information contained herein is subject to change without notice.

Microsoft® is a U.S registered trademark of Microsoft Corporation.
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Issues Addressed by Previous Patches

HP ALM 11.00 Patch 15

Certified Environments

ALM 11.0 patch 15 is certified with PC 11.0 patch 07

For an overall description of certified environments see the System Requirements section below.

Fixed Defects

General
QCCR1J16231 User defined lists of type "user list" were not available for the Automail condition.

QCCR1J21660 After adding a new attachment, the focus was kept on the first attachment instead of the newly
added attachment.

QCCR1J31538 In the Requirements Module Coverage Analysis view, when using an “OR” filter for requirements
type, coverage analysis was not shown.

QCCR1J31836 Full text search on Test Design Steps did not work when the DB used was SQL Server.

QCCR1J31595 Server was muted due to an out of memory error caused by corrupted data in the CROS_REF
table.

QCCR1J62824 When QC Sense data was stored in a different schema, the following error message was

displayed: "Failed to authenticate with db admin user ‘user name’.

Customization
QCCR1J30397 Custom groups were permitted to edit PC Lab project fields that should not have been editable.

QCCR1J62041 Sharing customization with a template over a project that was already linked to a template,
caused unexpected workflow behavior. Workflow scripts were not shared correctly.

QCCR1J62192 After installing the previous HP ALM 11.0 patch, the 'ActionCanExecute' event was executed
twice on the Defect Details page.

QCCR1J30587 The "CommandList.MoveUp" and "CommandList.MoveDown" workflow events were not triggered
when components were moved in a Business Process test by drag and drop.

QCCR1J61946 ALM Server would get muted when there were user operations trying to fetch a large number of
Test Runs.



Defect Module
QCCR1J32005 Copy and paste made the filter become case sensitive.

QCCR1J23149 When creating a new defect in QC/ALM 11 SP2 French edition, the "Statut" (Status) field
contained "New" by default, as in the English version of QC.

QCCR1J62344 After making changes to a defect, if a Standard Defects Report was opened and then canceled,
the changes to the defect were not kept.

Installation & Upgrade

QCCR1J25594 ALM MSiI installation package did not support deployment on multiple servers with the same
version of ALM.

QCCR1J27706 ALM 11.0 MSI installation was not certified on Microsoft Windows XP and Win7x64bit.

Integration

QCCR1J62170 Intermittently QuickTest Professional could not complete execution of a test in a test set upgraded
from a previous version.

Requirements Module
QCCR1J30568 When expanding the Release/Cycle tree, an error "Failed to Get Simple Key entity" occurred if
there was a filter on user defined fields that allowed multiple values.

QCCR1J31942 The connectors for imported BPMN business models (created with Bizagi Process Modeler) were
created as two way connectors after the import, instead of one-way connectors.

QCCR1J31957 In a version control enabled project, when logging in as a user belonging to a group with data
hiding on test/resource, navigating to the History tab of an entity in Business Models displayed an "Index was out
of range" error.

QCCR1J31666 The Rich Text field was improperly rendered in Requirements Project Reports.

There is still one limitation that font size and style of a number in a numbered list does not match the size and
style of the line in the Rich Text Ul.

This fix requires the additional manual step of uploading the ‘Style Template Fixed’ template as defaultStyle
Template for the project report.

QCCR1J61666 For requirements from imported libraries, the green asterisk in the Test Coverage tab was
displayed although there was no linked test.

QCCR1J31675 Removing Test Coverage from multiple scripts generated an error.

QCCR1J31566 In the Requirements Traceability view, the sort order was not saved.

Tests Module

QCCR1J30744 In the Automatic Runner window, when clicking on the gray area of the top menu bar, the mouse
cursor changed to a "move" cursor.
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QCCR1J23935 In the Test details window, the test type could not be changed from MANUAL to VAPI-XP-TEST.

QCCR1J62077 When running Business Process Tests manually, an error message was raised when parameters
were added to already included Business Components using the "<<< >>>" notation.

QCCR1J21209 The scrollbar in the Design Steps tab did not work properly when the test step description was too
long.

QCCR1J31838 Inconsistent behavior was experienced for a test instance when using Copy Default Values for
Parameters.

QCCR1J61623 When running a suite of QuickTest Professional scripts with more tests than hosts within a
defined Host Group, tests that were running stopped unexpectedly and another script in the queue took their
place on the host. "Test run stopped" appeared in the automatic runner for the test instance being executed by
the remote machine.

Note: The problem only occured under SQL Server database.

QCCR1J31602 Collate operation often could not be completed due to timeout.

QCCR1J31645 In Host Manager, double clicking the scroll area of the scrollbar caused hosts to be removed from
the list of Hosts in Group.

QCCR1J61658 In Test Lab, the error "Iltem doesn't exist" occurred and the Execution Grid became inaccessible,
if there was a data hiding filter to hide some test type in the Test Plan.

QCCR1J31580 In Host Manager, clicking the up/down button of the scrollbar would remove the first host from the
list of Hosts in Group.

QCCR1J27814 Design Step changes would be saved unexpectedly when clicking on the Description field of a
test.

QCCR1J32015 Two simultaneous users were not able to select or download attachments from the same entity.
The entity was locked by the first user's selection of the attachment.

Note: The entity is still locked for other users when one user renames, uploads, removes or changes the
description of an attachment. Other users cannot edit attachments during that time

Business Process Testing

QCCR1J17195 Business Components parameters could not be reordered.

QCCR1J28435 When running a Business Process Test manually, an error message was raised if during the run,
the status of one of the steps was updated to a value containing Kanji characters.

QCCR1J31667 Moving component requests out of the "component requests" folder was not functioning properly
in projects upgraded from QC 10.

QCCR1J62030 Providing multi-line values for Business Component parameters was not possible.
QCCR1J56 Adding a Business Component to a Business Process Test did not trigger a workflow event.
QCCR1J62695 Export defects to Excel could not be completed and the "Could not export to a file." error was
dislayed when a huge amount of data was kept in the comments field.

Export operation now warns if specific cells within the grid exceed 32k in size. The export operation succeeds, but
data beyond 32k is truncated. Cells with truncated data are colored red.
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QCCR1J31609 TDCommand protocol error occurred when navigating by td:// link.

Analysis

QCCR1J27342 Linked entities view was not available from the the Drill Down Results report.

QCCR1J31782 Versioning related fields were not included in Document Generator when Full page was used for
Requirement Entity reporting.

QCCR1J61945 In Live Analysis on a copied Test set folder, no information was displayed for the Test Instance
Progress Graph.

QCCR1J31614 User's live analysis graphs disappeared after upgrade from QC 10 to ALM 11.
QCCR1J31662 The Select Baseline option in project reports could not be selected.

QCCR1J31665 The Rich Text field was improperly rendered in Requirements Project Reports.

This fix requires the additional manual step of uploading the ‘Style Template Fixed’ template as default Style
Template for project reports.

Site Admin

QCCR1J30209 Site Analysis did not show the current day's result when selecting a Custom Period including the
current day.

QCCR1J28724 Updating a conflicting user record could not be completed on a Chinese edition of HP ALM.
QCCR1J61644 Import of a consecutive LDAP user by keyword was not possible.

QCCR1J62284 ALM project could not be accessed using multi-value UDFs over Oracle 11g.

QCCR1J25241 Upgrade to QC 11.0 could not be completed successfully if a Business Criticality criterion in
Customization of RBQM was set with a blank description.

Management
QCCR1J62006 Listing a release with a 100 or more cycles took a long time.

QCCR1J31895 A warning link appeared at the lower right of the Coverage Progress Graph (Management >
Release > Status > Progress Graph), and the graph did not display any data.

QCCR1J29634 When expanding the Release/Cycle tree, an error occurred if there was a data hiding filter on
user defined fields that allowed multiple values.

QCCR1J28332 Synchronizing Libraries between projects using baseline could not be completed and an error
message was displayed.

QCCR1J31651 A Manual test to a remote VC project could not be copied if the test called another test with actual
parameter values.

QCCR1J30378 Contradictory information for library synchronization appeared in the HP ALM User Guide and the
HP ALM Entities Sharing Best Practices Guide.
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QCCR1J22316 - In the Description text of Requirements, when highlighting text with special effects such as
strike-through, space, and quotes with colors, the colors were not retained after leaving the requirement.

HP ALM 11.00 Patch 14

Known Limitations

QCCR1J62234 Quality Center 10.00 allows the definition of component parameters with the same name provided
the parameter names are capitalized differently. However, when upgrading to a different version, this causes the
upgrade to fail.

Workaround: Rename one of the component parameters.

QCCR1J62220 Verify tool fails with error for Lab project schema while trying to access non-existing schema
Resources.

Enhancements

None

Certified Environments

ALM 11.0 patch 14 is certified with PC 11.0 patch 07

Patch 14, HP ALM 11.00 is certified for the following servers, databases, and tools:
e Oracle 10.2.0.5

e Red Hat 5.9 Linux

e Microsoft Internet Explorer 10 on Windows 7 SP1 x32

The following are some limitations relating to the new certifications:

e STM, BPT EE are not certified for Oracle 10.2.0.5, Red Hat 5.9 Linux, Microsoft Internet Explorer 10 on
Windows 7 SP1 x32

For an overall description of certified environments see the System Requirements section below.

Fixed Defects

Analysis
QCCR1J31041 A "Subscriptout of range" error was encountered in a Document Generator report when linking a
Component Input parameter with an Output parameter.

QCCR1J31323 Progress graph generation failed in ORACLE 10 ALM projects.
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QCCR1J61664 In Excel documents saved from an Analysis graph Data Grid, number columns were set as text.

QCCR1J30165 When sharing an analysis item within the Private Folder, an HTTP 500 error was encountered
after authentication.

QCCR1J31543 Large images in rich text were cropped in the Project report.

General

QCCR1J31289 "Invalid Server Response" and "server is not available" errors occured in some login scenarios.

QCCR1J31180 Tyring to use the function DownloadPictures, associated with a business process object,
resulted in an exception thrown by OTA: "Attempted to read or write protected memory.”

QCCR1J29896 IE and Alm-client.exe did not respond after clicking on Logout from the project.
QCCR1J30184 URL attachments with non-latin characters could not be opened.
QCCR1J31022 When trying to access folders in the Ul with a large number of attachments (3000+), the error "not

enough storage is available to process this command" occurred on the client.

Customization

QCCR1J30212 When getting a list of test instances from TSTestFactory, every 30" test instance had a testset ID
of -1.

QCCR1J30955 An error was encountered when trying to enter the Set Default Values dialog after a selected
default value was removed from the custom list.

QCCR1J30414 Granting group permissions to create and modifiy requirements also required granting permission
to cover those requirements with tests.

QCCR1J31531 In some projects a "Failed to apply customization changes" error occured when trying to save
new customization. To make this fix take effect you should clear the client side cache.

QCCR1J31341 The "Failed initializing plugin Requirements Plugin” error occurred after product installation in a
specific environment.

QCCR1J28323 In Cross Project Customization the Verify action did not thoroughly check fields as expected, and
did not warn that fields would be over-written or deleted.
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Defect Module
QCCR1J26922 User Defined Action button did not work properly in all modules.

QCCR1J30143 In specific upgraded projects, e-mail icons appeared in the defect details dialog box on items that
should not have had them (Status or Modified, for example).

Installation & Upgrade

QCCR1J27481 ALM_Demo QCP file could not be successfully imported.

QCCR1J30566 After project migration, accent characters in the description of the component's parameters were
replaced by HTML tags.

QCCR1J30957 In the upgrade of specific projects, the following error occurred: "SQL INSERT query has less
columns than actual Resource_Folders table defined".

QCCR1J30655 Project update could not complete successfully when redundant data existed in the
SYSTEM_FIELD table.

QCCR1J27060 The HP ALM Patch Unix installation did not have an option to choose an alternative ALM
deployment path other than the default path /opt/HP/ALM.

QCCR1J29582 Microsoct Office Export add-in stopped responding when activated by a user belonging
exclusively to a group set with a data-hiding filter.

Integration

QCCR1J30080 Excessive space characters were automatically cleared when set for a parameter value of a
scripted component.

QCCR1J31212 Rich text conversion could not be completed successfully when importing projects from QC 10.0
to ALM 11.0.

Versioning

QCCR1J30390 An error was encountered when trying to copy a folder from the Backbone project into another
empty folder in the Test Lab module.

Requirements Module

QCCR1J30526 Covering a requirement with multiple test folders requires significant time to complete. Proper
notification is now given to the user before such coverage is created, to allow cancellation in case this was done
by mistake.

QCCR1J27421 Filtering a large requirements tree view while keeping a hierarchical structure was slower than
expected.
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QCCR1J28425 A database error occurred on importing Business Models that were exported from Aris.

QCCR1J30341 Unnecessary emails were sent when clicking on Requirement History view in a version controlled
project.

QCCR1J31630 Newly typed in text was formatted using bullets after the bullet formatting was cleared from
existing text.

QCCR1J31649 Improper numbering was applied on numbered lists in the Rich text editor.

QCCR1J31542 Extra lines were unexpectedly added to the Rich Text field.

QCCR1J28425 Importing Business Models exported from Aris gave ORA-01795 error.

QCCR1J30669 The border lines of a table row in rich text were broken after merging the cells and undoing this
action.

Business Process Testing

QCCR1J27659 A "GenerateBPTWrapperTest System.NullReferenceException” error occurred when running
certain Business Process Testing Wrapper Tests.

QCCR1J31750 In large versioned projects, if parameters were added to business components already included
in Business Process Testing tests, an error “Failed to post simple key entity” occurred when trying to read or
update data from these tests.

Tests Module

QCCR1J28141 Changes made to the description field of a Test in the Test Plan module were not kept after a
Design Step was pasted into the Test.

QCCR1J30500 Copying and pasting a design step resulted in the focus being set on the first design step in the
test.

QCCR1J30473 When running a Business Process Testing Manual test, the value for the Actual field was not
posted propertly and caused information to be missing during testing.

QCCR1J28293 Creating a new Defect from Test Lab through Link Defects did not copy the Description details.

QCCR1J30871 An error was encountered when clicking on a test set containing QuickTest Professional tests:
"The opening tag 'br' in line 1 does not match the end tag of 'div'. Line 1. position 165",

QCCR1J31468 When copying a Test Set, the Tester field content was copied into the Test Instances in the new
Test Set, although the status of test run was No run. Now when a test set is copied, the Tester field is blank.
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QCCR1J30948 Tests with missing configurations and orphan Run results files in the Smart Repository were not
deleted from the Smart Repository (namely from SMART_REPOSITORY_LOGICAL_FILE and
SMART_REPOSITORY_PHYSICAL_FILE tables).

Other — OTA API

QCCR1J30271 Execution of a Business Process Testing test via a scheduler summoned via the TSScheduler of
OTA does not consider the test configuration settings — fixed only for Windows 7.

HP ALM 11.00 Patch 13

Known Limitations
QCCR1J30708 - Extra cells are pasted into the table when trying to fill it using cut+paste in MEMO and rich text
fields.

QCCR1J30669 — Border lines of table row in rich text are broken after merging cells and undoing this action.

Enhancements

QCCR1J29474/ QCCR1J29605 - HP ALM server can now connect to SMTP mail server with authentication
enabled. This is done by turning off the STARTTLS command using a new Site Parameter:
SMTP_ENABLE_STARTTLS=N

QCCR1J19252 - A dropdown was added to the Planned Host Name field in the Test Lab/Test Set execution grid
for selecting pre-defined hosts.

Certified Environments

As of patch 13, HP ALM 11.00 is certified for the following servers, databases, and tools:
e MS SQL 2008 R2 SP2
e PC11.00 Patch 7

The following are some limitations relating to the new certifications:
e STMis not certified on MS SQL 2008 R2 SP2

For an overall description of certified environments see the System Requirements section below.
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Fixed Defects

Analysis

QCCR1J30074 - In specific cases an exception occured when creating or generating a live analysis graph of the
Test Plan module.

QCCR1J30079 - The Edit Categories dialog box of a graph configuration in the Analysis module handled plus
sign characters as a carriage return.

QCCR1J26467 - The Requirements progress graph did not properly reflect the accumulation of requirements
across time.

e If an entity was created within the graph period with a NULL Group By field value, and this field was not
modified during the graph’s period, then the entity appeared as created (in the <unknown> group) at the
beginning of the graph period.

e If an entity’s Group By field value was NULL at the beginning of the graph period, and this field was
assigned a value during the graph’s period, then the entity appeared as newly created (in the new value’s
group) at the time of the Group By field modification.
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General
QCCR1J30201 - Uploading a file to the HP ALM server took longer than expected.

QCCR1J28138 - Some memory resources were not cleared as expected after consecutively switching between
projects.

Customization

QCCR1J25632 - Alert indication that a requirement linked to a test was modified was not displayed until logging
out.

QCCR1J29725 - In a user-defined field of multiple selections from a drop-down list, no error was displayed when
selecting too many items from the list exceeded the length of the field. As a result, the modification to such a field
was not saved.

QCCR1J29263 - Scorecard view of the Releases module could not calculate KPIs based on numeric user-
defined fields.

QCCR1J28956 - When the Performance Center extension was enabled for a template or linked project,
customization could not be applied from the template to the linked project.

QCCR1J29813 - A Test Run was created upon ending a test run, even though the Run_CanPost method in the
workflow was cancelled using Run_CanPost = False in the workflow code.

QCCR1J28688 - Grid columns remained displayed even if set to be hidden by workflow. A new site parameter
keeps these columns hidden: ENABLE_COLUMN_VISIBILITY_TRACKING=Y.

Defect Module
QCCR1J29332 - Exporting the Defect Grid view to Excel took longer than expected.

Installation & Upgrade

QCCR1J29470 - The Site Administration schema could not be accessed and patch installation failed if schema
connectivity details were modified only in the siteadmin.xml file and not in the qcConfigFile.properties file. The
issue is now resolved by retrieving the connection details from the siteadmin.xml file.

Integration

QCCR1J29278 - An Excel add-in based document showed wrong characters for Korean field names.

QCCR1J29998 - Notepad application failed to launch and an error message was displayed after clicking the
Launch Notepad button on the “HP ALM Export Wizard - Scan Error Report” dialog box of the HP ALM Excel add-
in.
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QCCR1J29995 - New role created in a project template did not reflect all permissions set for that role when
utilized in a project based on the template.

QCCR1J29301 - HP ALM could not be connected from Quick Test Professional after installing both HP ALM and
Quick Test Professional in silent mode, and activating Quick Test Professional by a non-admin user via Citrix.

Libraries and Baselines

QCCR1J30446 - Size and date details of attached files with comma characters in their file names were not shown
properly when viewed from baseline.

Releases

QCCR1J29737 - The Scorecard tab of the Releases module displayed a warning when too many cells were
selected. Now rows or columns in the scorecard are truncated to fit the maximum size limit (900 cells).

Versioning

QCCR1J29810 - In a version controlled project, viewing the History of a requirement that had not yet been
checked out resulted in the sending out of unsolicited email.

Requirements Module

QCCR1J29177 - In specific scenarios one could not assign a cycle to child requirements after assigning a cycle
to the parent requirement.

QCCR1J29334 - Setting a URL in a rich text field converted special characters such as ampersand to URL
encoded characters.

QCCR1J24270 - A rich text template defined with a multiple table structure was not displayed properly.

QCCR1J29056 - When an entire table column inside a rich text field was selected and cut to the clipboard, only
the content was cut and the column remained part of the table.

Site Admin

QCCR1J31073/QCCR1J31069 - Server connections were not properly released even after considerable time
passed following a timeout defined by the site parameter of Wait_Before Disconnect.

QCCR1J30977 - Copying a project with the MSTM extension enabled, copied the requirements when only
Customization was set to be copied.

QCCR1J29921 - Quality Center license was not released after user was disconnected by inactivity timeout.

25



Business Process Testing

QCCR1J29062 - Some components were missing from the Choose Components dialog box after attempting to
apply invalid filter criteria.

QCCR1J29491 - The upgrade process of an HP Quality Center 9.2 project to HP ALM 11.0 on Unix made wrong
use of the slash character in the repository path. As a result, objects in Business Process Testing components
were displayed using question mark icons instead of their actual test object icon, and failed to run from Quick Test
Professional.

QCCR1J20331/QCCR1J26555 - Double-clicking the scrollbars of the Test Script grid for a business process test
unintentionally opened the Component Details dialog box.

QCCR1J30084 - The Quick Test Professional process kept running after a business process test failed and was
set to exit On Failure.

QCCR1J29825 - An Automatic Runner test set with a Host Group failed with "Another test is running”, instead of
waiting for the host to become available.

QCCR1J29805 - After upgrading a Quality Center 10.00 project to HP ALM 11.00, the values of business process
test parameters got mixed up during execution.

QCCR1J30037 - The default value of Test Parameters in Test Plan > Test Configuration > Data for business
process tests was not displayed correctly.

Tests Module

QCCR1J29416/QCCR1J29653 - Copying a project with the MSTM extension enabled, copied some attachments
when only Customization and Users and Groups were set to be copied.

QCCR1J29205 - The Execution Date of a test instance was not refreshed to reflect a Fast Run execution.

QCCR1J30111 - Copying and pasting a test set resulted in an error message when data hiding was defined for
the Test module, even though the test set was eventually pasted properly.

QCCR1J29762 - Quick Test Professional test set execution did not stop when a failure occurred, even though the
On Failure instruction was set to "Stop the Test Set". Now the test set execution stops on failure, however it
should be noted that the following cases do not constitute failed tests: Host is not available, Quick Test
Professional is not installed on the destination host, and Quick Test Professional agent fails to run the test.

QCCR1J22896 - Exporting the Test Plan grid view to Excel after re-ordering the grid columns did not reflect the
new column order.

QCCR1J29467 — Values entered in Test Run fields such as Actual, Expected and Description were not kept after
opening the Attachments dialog and clicking the Cancel button in that dialog window.
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HP ALM 11.00 Patch 12

Enhancements

General

Clicking the More Add-ins link on the Add-ins page now displays the new HP Application Lifecycle Management
Resources page. From this Resources page, you can:

e Access HPLN for downloading add-ins
e Read “What’s New” for each HP ALM version

e View product movies

Attachments

QCCR1J20785 — A new site parameter, ATTACH_TOTAL_MAX_SIZE, limits the size of attachments for a
specific entity. This new parameter joins the already-available parameter of ATTACH_MAX_SIZE, which limits the
size of an individual attachment.

The new parameter can be used to align the maximal total attachment size of an entity to match the email
attachment limit to allow proper emailing of entities. Note that the maximal attachment size of sent emails in ALM
is 2048KB.

Proxy Server

QCCR1J27589 — Performance has been improved for ALM connected over a reverse proxy server.

Certified Environments

As of patch 12, HP ALM 11.00 is certified for Performance Center 11.00 Patch 7.

Fixed Defects

Defects Module

QCCR1J25187 / QCCR1J29180 — Spaces in a defect description that contain Korean characters were replaced
by carriage return (new line) characters when exported to Microsoft Excel.

QCCR1J27722 - Filtering defects using the [CurrentUser] value did not work properly if the user name was
capitalized and Oracle was the DBMS of the project.

QCCR1J27845 — Adding new text and table structure to the Comments field of a defect distorted the comment’s
content.

QCCR1J28015 — The "Field requires a value from the corresponding list” error was displayed when changing the
value of a field that is linked to a list in a newly-created defect.
Requirements Module

QCCR1J27421 - Filtering a large requirements tree view while maintaining a hierarchical structure was slower
than expected.

QCCR1J28429 — The addition of columns to the Traced to Requirements tab in the Traceability Matrix view were
not saved as part of the Favorite filter.

QCCR1J28442 — Importing business models under certain condition caused an exception and the following error
was displayed: “Failed to Import Model Post Process; Unexpected failure in getValuePostProcess;...”

QCCR1J28727 — When creating a copy of a project that has images in the rich text portion of the requirements,
the images were not retained in the copied entities.
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QCCR1J28908 — Requirements copied from a particular project and pasted into another project resulted in the
Target Release and Target Cycle fields being updated with default values.

Tests Module

QCCR1J27773 — Retrieving the entire result set of the Runs view under Test Instance Details using the "Retrieve
all <x> results" link did not show the expected full result set.

QCCR1J27810 — Adding a large number of tests (over 2,000) to a test set at once was nhot possible.

QCCR1J27899 — Tests could not be imported using the Microsoft Excel add-in in HP ALM 11 projects that were
upgraded from Quality Center 10.00.

QCCR1J27950 — When creating a new design step, the focus was on the Step Name field instead of the
Description.

QCCR1J28529 - When creating child folders to a folder already assigned to a cycle in the Test Lab module, only
the first child folder inherited the cycle assignment.

QCCR1J28695 — The madification of the Actual field of test step were not kept if the filter of the steps was
modified while the cursor was kept in the Actual field.

QCCR1J28696 — Changes to the Requirement Coverage on tests were not retained if the project is managed by
version control.

QCCR1J28771 — Text of a design step that was formatted using automatic numbering or bullets was not
displayed properly in the Step Details of the Last Run Report.

QCCR1J28833 — Pasting large test sets in version-controlled projects using Oracle took a considerable amount of
time to complete.

QCCR1J27302 — The re-ordering of tests in Execution Flow tab of the Test Lab module was not visible in the
Execution Grid in the Automatic Runner.

QCCR1J27831 — Test memo fields’ values were displayed improperly when accessing ALM using the Korean
Windows XP SP3 operating system.

QCCR1J28073 — User could not move test set folders, even if the users had permission to do so.

Business Process Testing

QCCR1J29337 — An error occurred for some projects having large number of tests when adding components to
tests.

QCCR1J28892 — The lIterations window could not be opened when group of components are specified in a test
script having many iterations.

QCCR1J24481- The reference to a test case flow was not properly pasted or imported after copying or exporting
a business process test case that makes use of flows.

QCCR1J28728 — The component name was reset with a default one after requesting a component in the Test
Plan module and then adding steps and parameters before submitting.

QCCR1J29361 — Saving the modified value of business process tests by pressing the <Enter> key displayed an
error.

QCCR1J27480 — The test coverage indication in the requirements view was incorrect after the criterion of the test
coverage was modified.

QCCR1J27841 — An application area could not be opened by pressing the Launch QTP button, namely when a
new application area was created that uses the .Net, WPF and Web add-ins.

QCCR1J28516 — The output parameter values of a business process test, whose execution lingers, were not
kept.

QCCR1J28945 — Library synchronization failed when components were deleted in both the Export and Import
sides.
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LoadRunner
QCCR1J27507 — An exception occurred when executing Load Runner 11.04 from ALM.

VAPI-XP
QCCR1J28041 / QCCR1J 28225 — The srunner.ocx component issued an exception after running VAPI-XP
tests in ALM.

API
QCCR1J29211 — Memory consumption was not properly cleared when traversing the Test Set module using API.

QCCR1J28207 - In specific cases of integrating Executive Scorecard (XS) 9.30 and HP ALM 11.00 over Oracle,
the API call result returned an ORA-01795 error.

QCCR1J28457 — In a newly-created test set, the Type system field did not get a value when the test set was
added using API. As a result the test set could not be opened.

Libraries and Baselines

QCCR1J27309 — The renaming of folders was not synchronized properly from baselines.

QCCR1J28568 — The Import of libraries failed for specific projects created in ALM Chinese edition.

QCCR1J28569 — Requirements were not synchronized between projects if the requirements were added to a
library individually and not within a folder.

QCCR1J28332 — Synchronizing libraries between projects using baselines failed with an error.

QCCR1J28953 — Synchronization resulted in an error after deleting a folder and all its sub entities in a target
project, while in the source project addition and deletion took place under the same folder.

QuickTest Professional

QCCR1J28517 — Accessing very complex QuickTest Professional tests caused QuickTest Professional to stop
responding.

QCCR1J29103 — Loading tests into QuickTest Professional took a considerable amount of time, especially when
opening tests with calls to external actions using relative paths.
Install the QTP_00990 QuickTest Professional hotfix from the following location:

https://patch-hub.corp.hp.com/crypt-
web/protected/viewContent.do?patchId=QTP 00990&product=crypt%3Aquicktest¥$3A&hasProd
Breadcrumb=true

QCCR1J29119 — The ALM client did not respond after switching to the Execution Flow tab of a test plan of a
QuickTest Professional test that was run with multiple iterations.

Workflow

QCCR1J28815 — Defect fields that are hidden using the data-hiding filter were not accessible for read and write
actions using workflow script.

QCCR1J28321 — Removing a Host from the Host Manager using the RemoveHost API method resulted in an
error.

Installation

QCCR1J26685 — The MMerge.exe and QCClient.PerformanceMonitor.Ul.exe files failed to download when
installing the client from Internet Explorer.

Reports

QCCR1J28359 - In version-controlled projects, when creating a test lab report using the Document Generator,
the version-related information was not included in the resulting document.
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General
QCCR1J29222 — The ALM client could not connect over a Forefront Threat Management Gateway server.

QCCR1J29655 — The ALM login page could not be reached when trying to access it through Citrix Netscaler over
HTTPS.

QCCR1J24647 — Import of a release from a template failed due to the attempt to employ an additional connection
to the template.

QCCR1J26731 — Customization information that is cached on the client side did not affect the login time. Now the
cached information is properly used and the login time is reduced.

QCCR1J27055 — The Replace option used in a test plan view that is filtered by date field replaced all tests
regardless of the set filter.

QCCR1J27759 — The name of customized module was not displayed as expected. Module name is set by default
to the Module ID. You can explicitly set the Module display name by adding the following tag to the config file:

<Parameter name="DisplayName" value="DisplayName "/>

QCCR1J27988 — The dialog box that is displayed in the Verify/Apply project template process showed a Cancel
button instead of a Close button.

QCCR1J28612 — ALM did not display user-defined lists of type "user list" as a condition criterion in the Automail
section of project customization.

QCCR1J28999 — The custom properties of a Microsoft Word document that utilizes the HP ALM Word Add-in
were cleared after saving the document.

QCCR1J28571 — The User Name and Domain fields of the Auto Restart Setting dialog box of the ALM System
Test Agent were read-only when executed on a Windows 7 64bit operating system.

QCCR1J24976 — Business Process Modeling import issues occurred with QualiWare Lifecycle Manager (QLM), a
business process modeling tool.

QCCR1J24642 — Tests that are linked to a test set were not displayed as linked upon changing the test coverage
of a version-controlled project.

QCCR1J29811 — Upgrade issues were encountered in previous patches in cases where ALM 11.00 was installed
as "copy and upgrade" for Quality Center 9.20 / Quality Center 10.00.

QCCR1J28902 — Choosing the “Do not show this dialog box again” option in the Choose Client Certificate dialog
box resulted in the inability of the ALM client to connect to the ALM server.
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HP ALM 11.00 Patch 11

Certified Environments

As of patch 11, HP ALM 11.00 is certified for the following servers, databases, and tools:
e Performance Center 11.00 Patch 6
e Service Test is certified on MS SQL 2008 SP3

e Service Test is certified on Red Hat 5.8 64-bit as a server operating system

For an overall description of certified environments see the System Requirements section below.

Fixed Defects

Analysis View

QCCR1J21211- An error occurred when generating a project report for requirements using a cross-filter.

QCCR1J26941 - Ancestors of requirement records were not displayed in a project report even if the Keep
Hierarchy option was checked in cases where the filter being used related to a parent field.

QCCR1J27120 - Reports were not printed properly when HP ALM was running on a Windows 7 64-bit operating
system using Internet Explorer 9.

QCCR1J28518 - The progress graph displayed data for entities that are missing their historical information. Now
the progress is based only on entities with historical information (i.e., Audit log).

Upgrade

QCCR1J27230 - Migration of Performance Center projects (with more than 1000 tests) using the PC migration
tool failed. Either the project tests were not migrated or the migration failed to complete, because of a deadlock.

QCCR1J26772 — User-defined fields added to the Releases module using an OTA based tool in HP Quality
Center 10.00 were missing after the project was upgraded to HP ALM 11.00.

Requirements

QCCR1J27330 - An error occurred when viewing the coverage analysis of requirements for which tests were
automatically generated.

Baselines

QCCR1J27126 - An error was encountered during library synchronization of an ALM project. A deleted resource
caused a NullPointerException that in turn led to a library synchronization failure.
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Business Process Testing

QCCR1J28023 - When running a business process test or flow with UFT, a redundant call was made to the
server.

QCCR1J27395 - Check-in and check-out of business process tests did not work properly due to an internal query
block.

Test Plan

QCCR1J26709 - A user that is assigned to a group that is permitted to create and update design steps could not
create a new design step by means of copy/paste, and could not use the renumbering functionality. To have this
fix take effect, follow these steps:

1. Add the following line to the "verify_tasks_deep.xml" file that is located under

"repository\sa\DomsInfo\MaintenanceData\conf" folder:
<ENTRY VALUE="com.mercury.td.saserver.maintenance.verify.
EntityUpdatePermissionInconsistencyTask"/>

2. Add the following line to the "repair_tasks.xml" file that is located in the same folder as the above file:
<RepairData class="com.mercury.td.saserver.maintenance.repair.
EntityUpdatePermissionInconsistencyRepairer"/>

3. Restart the ALM server.

4. Run the Project Repair tool.

For the full instruction please refer to http://support.openview.hp.com/selfsolve/document/KM00209162.

QCCR1J27319 - The search criteria for tests were not retained after selecting a test from the search output,
adding requirements to it, and returning back to the search result view.

QCCR1J26969 - After deleting one step out of many in a test script, the first step became the current record in
the list instead of the step that preceded the deleted one.

QCCR1J26912 - The drop down option of the Search field in the Test plan module that keeps the previous
searches was populated with redundant empty lines for every component one navigated to after a given search.

QCCR1J27554 - An error occurred when switching to the Application Area tab of a test resource after a library
was imported into the project.

Test Lab
QCCR1J26871 - In Test Lab, selected CC recipients for email notifications were not saved.

QCCR1J27426 - In a version controlled project, the mark of a used parameter was not properly removed after a
design step using the parameter was deleted.

QCCR1J27163 - The test parameter field TP_DEFAULT_VALUE could not be modified by all the custom groups
that have permission to modify it.

QCCR1J27210 - When adding tests to a test set using a filter, tests not included in the filter were added to the
test set when a user clicks the Subject (root) folder while adding tests from the filtered Test Plan tree.

QCCR1J26902 - Actual values of a test configuration were not saved after setting these values using the Copy
Default Values option.
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QCCR1J27002 - When Smart Repository was enabled, copying a test with run results resulted in orphan records
in the SMART_REPOSITORY_LOGICAL_FILE table.

QCCR1J27334 - User could not delete a test Instance in cases where the Delete Test Instance and Delete Run
permissions were set to "By owner only" even if the same user was the owner of those entities.

198613 — The Planned Host Name field in the Test Lab -> Test Set Execution Grid does not provide a dropdown
arrow for choosing the name.

Integration

QCCR1J26931 - QuickTest Professional was unable to connect to HP ALM through HP Partner Reverse (Web)
Proxy.

QCCR1J26249 - Sprinter could not connect to HP ALM through a reverse proxy with digital certificate
authentication.

QCCR1J26055 - An HP ALM deployment integrated with SiteMinder for authorization resulted in an occasional
"Invalid Server Response" error message a few hours after initial connection.

Workflow

QCCR1J26782 - Cancelling the _FieldCanChange function in a workflow did not restore the old value of the
corresponding field. This defect was encountered when using ALM Explorer and advancing to a field other than
the validated field.

QCCR1J26804 - An error occurred when refreshing a subfolder in the Test Plan module using a workflow script.

QCCR1J27422 - Values of TestSetTest_Field of a workflow were not retrieved consistently when running a
manual test run.

QCCR1J27193 - In a Test Lab workflow script, the value of the step's Test ID field (i.e.,
Step_Fields.Field("ST_TEST _ID") returned the test name instead of the test ID.

Version Control

QCCR1J23015 - When editing a lookup-list field for a checked-in entity, the checkout worked as expected but the
modified value was not kept.

Site Administration

QCCR1J27385 - In shared mode installation, the client files used by Site Administration were stored under the
user's profile location instead of under a shared location.

QCCR1J27634 - An error occurred when importing users from LDAP by keyword and the result of the LDAP
query was empty.

QCCR1J27529 — When deleting a user from the Site Administration console while the user entry is locked in the
Project User list of project customization, the user record is kept in the project users list though not displayed in
the Site Administration users list.

Microsoft Word Add-in

QCCR1J28062 - An error was encountered when requirements were imported into HP ALM using the MS Word
add-in and the number of imported requirements exceeded 32,000.
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Customization

QCCR1J27830 - A redundant warning message of "Removing a field may result in data loss" appeared when
performing cross project customization and clicking the Verify button.

QCCRIJ24904 - An error occurred when viewing the history of an entity after a user-defined field, that initially had
its History option enabled, had the History option removed and then the user-defined field was deleted entirely.
Now, upon deleting a user-defined field, its previously-recorded history is also deleted.

Malil

QCCR1J25185 - If Korean characters were typed in the body of a mail, space characters were replaced by new
line characters when the mail is received.

General

QCCR1J27115 - The display of the progress bar indicating the progress of uploading or downloading an
attachment did not reflect the actual progress.

QCCR1J25852 - Download of attachments that are larger than 2GB was not possible.

QCCR1J26493 - In certain scenarios, the message "Invalid Server Response" was issued repeatedly by the HP
ALM client.

QCCR1J26789 - An error was encountered when a project was created by copying data from an existing project
and all project content options were selected.

QCCR1J26818 - Read-only memo fields that are displayed in a grid were missing the drop down option to expand
their content for full viewing. The drop down option is not available in the following grids that are entirely read-
only:

e Tests grid in Business Models module > Linkage tab

e Business Model Linkage in Requirements module

e Graphs' drill down results

QCCR1J26790 - Hiding the indication columns in grid views was not kept persistent for consecutive sessions.

QCCR1J27189 - Non-English diacritics (e.g., umlaut) in defect data were not exported properly to a Word file.

QCCR1J27566 — HP ALM server installed with the Performance Center extension reached an out-of-memory
state in case a folder had over 4 million files.

QCCRIJ27463 - ALM Explorer running on Windows XP SP3 having Internet Explorer 6 installed and using a

proxy server did not perform properly.

QCCRIJ27494 - After reaching the high limit of the Smart Repository, user cannot create components and
attachments and receives an error.

QCCRIJ27100 - MSI Installation - Running a generated MSI installation with Shared Deployment mode failed
when no network connection was available.
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QCCR1J27389 - The SQL statement used for Test Set queries did not bind literal values causing each individual
statement to be parsed and cached individually. Now binding is used to consolidate many individual statements
into a single structure.

QCCR1J27197 — A memory leak was found in the utilization of Spider.

QCCR1J25555 - New entities could not be created in a newly-created project whose Customization data was
copied from a different project.

QCCR1J26864 — Updates to the summary field of a defect were kept only on a consecutive update when the
update was made in grid view.

QCCR1J28100 — An “Out of co99ntext” warning message was displayed while selecting attached files in the New
Defect dialog window.

HP ALM 11.00 Patch 10

Enhancements

Tests

QCCR1J24345 - You can now create cross filters in the Test Lab module’s tree by Responsible Tester.

QCCR1J25247 - A warning message, that is displayed when editing a called test’s steps while the called test is
running, was repeatedly displayed for every step. Now this message is displayed only once.

QCCR1J25867 - In the Test Plan module, the state and position of the Test Configurations bottom pane under
the test selection tree is now persistent for each user.
Project Planning and Tracking

QCCR1J20958 - Release scope items are defined by including requirements, tests, test sets, and defects.
Now you can also filter which defects to include.
In the Releases module > Release Scope tab, you can include one of the following:

e Defects that match certain criteria.
o Defects that are linked to certain requirements, tests, and test sets.
Note: Links between defects and test sets also include indirect links to: Test instances, Runs and Steps.

KPIs related to defects (such as Severe Defects) are calculated accordingly on scorecards, providing a greater
measure of accuracy.

Installation

QCCR1J25593 - MSI Generator now supports combinations of Registered and Shared files in the same locations.
QCCR1J25594 - MSI packages now support deployment of multiple ALM servers.

QCCR1J25296 - Silent installation is now available for SystemTest Agent.
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Note: The silent installation of SystemTest agent cannot be executed on Windows Vista and Windows 7 when
User Account Control is enabled.

General

QCCR1J22456

Login to ALM over HTTPS with client certificates is now supported.

Certified Environments

As of patch 10, HP ALM 11.00 is certified for the following servers, databases, and tools:
e Oracle11.2.0.3

e MS SQL 2008 SP3

e Windows 7 SP1 32Bit as Client OS

e Red Hat 5.7 64bit as Server OS

¢ Red Hat 5.8 64bit as Server OS

e PC 11.00 Patch 6

The following are some limitations relating to the new certifications:

e STM, ST are not certified on Oracle 11.2.0.3, MS SQL 2008 SP3

e STM, ST are not certified on Windows 7 SP1 32 bit as client OS

e STM, ST are not certified on Red Hat 5.7 64bit, Red Hat 5.8 64bit as server OS

For an overall description of certified environments see the System Requirements section below.

Fixed Defects

Analysis View

QCCR1J24516 - The filter of coverage analysis view did not work as expected and